User guide for developed DLLs for real fluid property models in IPSEpro process simulator

Mondejar, Maria

2015

Link to publication

Citation for published version (APA):
Mondejar, M. User guide for developed DLLs for real fluid property models in IPSEpro process simulator

General rights
Copyright and moral rights for the publications made accessible in the public portal are retained by the authors and/or other copyright owners and it is a condition of accessing publications that users recognise and abide by the legal requirements associated with these rights.

• Users may download and print one copy of any publication from the public portal for the purpose of private study or research.
• You may not further distribute the material or use it for any profit-making activity or commercial gain
• You may freely distribute the URL identifying the publication in the public portal

Take down policy
If you believe that this document breaches copyright please contact us providing details, and we will remove access to the work immediately and investigate your claim.
User guide for developed DLLs for real fluid property models in IPSEpro process simulator

2015

Maria E. Mondejar
Division of Thermal Power Engineering
Department of Energy Sciences
Contents

1. What is in this guide? ........................................................................................................... 3
2. How to create a DLL for IPSEpro ..................................................................................... 4
   2.1. Steps to follow to develop a DLL ................................................................................. 4
   2.2. Create a DLL to call the Refprop DLL subroutines .................................................. 7
   2.3. Check the DLL compilation ......................................................................................... 8
3. Using the DLL from IPSEpro ......................................................................................... 10
   3.1. Installing the DLL ......................................................................................................... 10
   3.2. Calling the DLL functions from MDK ......................................................................... 10
   3.3. Usage of the developed DLLs ...................................................................................... 11
   3.4. Additional information ............................................................................................... 13
4. Publications ...................................................................................................................... 14
5. Additional sources of information .................................................................................. 15
6. Acknowledgements .......................................................................................................... 16
7. References ....................................................................................................................... 17
1. What is in this guide?

This guide is intended for beginner users of IPSEpro process simulation software [1] and contains a brief introduction on the development of dynamic link libraries (DLL) with external functions to be used in IPSEpro, as well as a short explanation on how to use the DLLs created at the Division of Thermal Power Engineering at Lund University, for the use of real fluid property estimation.

The DLLs presented here are enumerated as follows:

- **Multi.DLL**: a DLL for property estimation of multicomponent fluid mixtures, by using Refprop subroutines.
- **SeaWater.DLL**: a DLL that contains correlations for property estimation of seawater.

Detailed information on the development of DLLs for IPSEpro can be found at the section 11 of the user manual for the Model Development Kit of IPSEpro, and other references mentioned in section 5. However, this guide provides a quick start guide for those who want to use or modify these DLLs, with general tips based on my experience on their development.
2. How to create a DLL for IPSEpro

As already mentioned, the detailed instructions for the development of dynamic link libraries (DLL) for their use in IPSEpro can be found in the section 11 of the user manual for the Model Development Kit of IPSEpro. Only a basic description is given here.

The instructions in this user guide are based on my experience and refer to the development of DLL using Microsoft Visual Studio 10 and C++ as the programming language. The version of IPSEpro was 5.1, and that of Refprop was 9.1.

2.1. Steps to follow to develop a DLL


   **Go to:** File > New > Project > Visual C++ > Win 32 Project > Name and location of the project > Next > Select DLL > Finish

After this, you should see something similar to Figure 1.

![Figure 1. General view of the Microsoft Visual Studio panel.](image-url)
2. Header files (.h) are generated automatically, as well as dllmain.cpp and stdafx.cpp (they can be found in the solution explorer). The code referring to the function must be inserted in name_of_dll.cpp

3. The following property must be changed to avoid compilation problems. In the solution explorer:

right click on the project name > Properties > General > Character Set > Set to Multi-Byte Character Set

4. Write the code of the external functions:

The external functions must have the specific format shown in Figure 2. Because the solving process of IPSEpro is based on the Newton’s method, it is necessary to define, for each function, the partial derivatives for each of the input variables. Figure 2 shows the general required format of the functions.

```cpp
#include <windows.h>
#include <stdio.h>
#include “stdafx.h”
using namespace std;
#define EXTERN_FUNCTION __declspec(dllexport) _stdcall

// Function declarations
extern “C”
{
    double EXTERN_FUNCTION name_of_function(variable_type variable_name, ...);
    double EXTERN_FUNCTION partial_derivative(variable_type variable_name, ...);
    ...
}

double EXTERN_FUNCTION name_of_function (variable_type variable_name, ...)
{
    function_operations;
    return function_output;
}
```

*Figure 2. General required format of the functions.*

1. It is important to notice that IPSEpro only accepts input and output variables of type `double`.

2. In certain cases, not defining the partial derivatives of a function can be valid. This occurs when the variables are set as parameters, and it is not expected to use the IPSEpro solver to estimate their value (e.g. if the variable of a function is the composition of a mixture, this parameter is always set, and therefore the partial derivatives are not needed.
5. When the code of the DLL is ready, build it:

**Build > Build solution**

The result of the compilation will be shown in the compilation output window, and should look like this:

![Compilation Output](image1.png)

**Figure 3. Result from the compilation of a DLL project: a) successful compilation; b) unsuccessful compilation.**

6. If the compilation is successful, the DLL can be found in the projects folder, under the subfolder ‘Debug’.

![DLL Project Folder](image2.png)

**Figure 4. DLL project folder content. The compiled DLL is found in the subfolder ‘Debug’**.

7. If the compilation is not successful, the compilation output window will show a list with the compilation errors and their location in the code. This list is not 100% reliable but it can serve as a guide for debugging the code. Typical errors that provoke the compilation to fail are:
The declared number of functions does not correspond with the number of functions defined.

There is a mismatch between the number of inputs in the declaration, and in the definition of a function.

Spelling errors.

Lack of necessary headers (e.g. Refprop.h, windows.h...).

### 2.2. Create a DLL to call the Refprop DLL subroutines

In order to be able to call the Refprop subroutines from our DLL some modifications on the syntaxes are needed. The necessary files for this can be downloaded at the [official web page of Refprop NIST](http://www.boulder.nist.gov/div838/theory/refprop/LINKING/Linking.htm#CApplications):

First, the file `refprop2.h` must be copied in the same folder where you have the C++ code. Then the file `refprop.dll` (from the Refprop installation folder) must be copied in the same path where the IPSEpro library will be allocated.

The function code must now include the call to the Refprop DLL:

```cpp
#include <windows.h>
#include <stdio.h>
#include "stdafx.h"
#include "refprop2.h"
using namespace std;
```

Fig 5. General required format of the functions, including call to Refprop subroutines.

The file `EX_C2.c` from the package downloaded at the Refprop website contains a code example to call the Refprop subroutines. The DLL with functions for IPSEpro can be developed based on this example. Most of the information needed for the modification of the example is given in the comments, but a short key is provided here:

```plaintext
long i       number of components in a mixture
double x     array with components molar fractions
char hf      string with name of the mixture components (e.g. “isobutan.fld|ipentane.fld”);
char hrf     reference state (“NBP”, “DEF”, ...)
char hfmix   mixture model (i.e. “hmx.bnc”)
```
The main characteristics of the code are the following:

- The file `refprop2.h` contains the headers to all the Refprop subroutines, as well as their structure (number and type of input variables). As all the variables from IPSEpro are of type double, it is necessary to create functions in the DLL that ‘convert’ those into other types, if needed. This was done in the DLL developed for mixtures, where each fluid is selected following a reference number that can be found in the Annex I.

- The description of the Refprop subroutines, and each of their input variables, can be found in the file `MANUAL.txt` of the folder ‘fortran’ of the Refprop installation folder.

- The syntaxes to call a Refprop subroutine from the C++ code follows the following structure:

```
SETUPdll = (fp_SETUPdllTYPE) GetProcAddress(RefpropdllInstance,"SETUPdll");
//Initializes the program
SETREFdll = (fp_SETREFdllTYPE) GetProcAddress(RefpropdllInstance,"SETREFdll");
//Initializes the reference state for mixtures
PHFLSHdll = (fp_PHFLSHdllTYPE) GetProcAddress(RefpropdllInstance,"PHFLSHdll");
//Get address of subroutine PHFLSH
SETUPdll(&i, hf, hfmix, hrf, &ierr,herr,refpropcharlength*ncmax,refpropcharlength,
lengthofreference,errormessage length);
//Calls setup with the defined values for i, hf, hfmix, hrf
SETREFdll(hrf, &ixflag,x0,&h0,&s0,&t0,&p0,&ierr,herr,lengthofreference,errormessage length);
//Calls setref with the defined values for hrf,x0,h0,s0,t0,p0 (reference state values)
PHFLSHdll(&P,&H,x,&t,&d,&dl,&dv,xliq,xvap,&q,&e,&s,&cv,&cp,&w,&ierr,herr,errormessage length);
//Calls the subroutine to calculate (in this case) the state conditions with pressure and //enthalpy as inputs
```

*Figure 6. Syntaxes to call the Refprop subroutines from C++ code (found at EX_C2.c).*

① By default, the reference state for the calculation of mixtures properties was set to NBP (normal boiling point). In order to change it, this should be made in the source code of the DLL.

### 2.3. Check the DLL compilation

In order to test the compilation of the DLL before calling it from IPSEpro, open the command prompt:

```
Start > All Programs > Microsoft Visual Studio > Visual Studio Tools > Visual Studio command prompt > go to the dll folder and write:
dumpbin /exports NameOfDLL.dll
```

The output should look as in Figure 7.
As it can be observed in Figure 7, the number of exported functions should agree the number of names (definitions). Each exported function appears as `function@bitsnumber`, where the bits number corresponds to 8 times the number of input variables of type `double` (see IPSEpro manual for more information on this). This is an important step to check for the correct exportation of the functions.
3. Using the DLL from IPSEpro

3.1. Installing the DLL

The first step to use the developed DLL in IPSEpro is to copy it into the folder where the IPSEpro library files are. If the DLL calls the Refprop subroutines, the \texttt{refprop.DLL} should be also copied into this folder.

3.2. Calling the DLL functions from MDK

The DLL functions are called from the MDK. External functions can be used in Connections, Global variables and Units. New functions can be created from the MDK code by adding an External Function.

The first step to implement a new fluid type is to create a Global variable that contains all the functions exported by the DLL. Figure 8 shows the window for the definition of the external function. It is important to notice that the function and derivative names must be the same as the ones exported in the DLL. The inputs name can differ.

![Figure 8. Definition of external function in MDK.](image)

Secondly, new Connection and Units can be created, based on the new Global. It is important to notice that the same Unit can have connections from different Globals, which means that different property estimation models can be used for different streams on a same unit.
Typical errors that can appear at this stage are:

- No convergence of the DLL functions → Revise calculation in the source code
- Different name of function in MDK and DLL file
- Different number or type of variables for the functions

### 3.3. Usage of the developed DLLs

In this section the basic instructions to use the DLLs developed at the Division of Thermal Power Engineering are explained.

**DLL for property estimation of binary mixtures with Refprop (Binary.DLL)**

A DLL for the property estimation of binary mixtures using the Refprop subroutines was developed and presented in [3], where a list of the provided functions is given. The way to define a binary mixture with this DLL is to create a **Global** variable with the new DLL functions and define its components and composition as shown in Figure 9.

**Figure 9. Definition of the Global variable for binary mixtures.**

Here, **FluidID1** and **FluidID2** correspond to the reference numbers of the desired mixture components (see Annex I for the reference numbers of the fluids). Only pure components can be referred to here (which means that Refprop predefined mixtures and pseudo-pure fluids are not included). The variable **x1** refers to the molar fraction of the first component of the binary mixture. All of the parameters should be set.

1. If a single component fluid is to be used instead, it is enough to set the variable **x1** to 1.0.

2. It is not possible to estimate any of the variables FluidID1, FluidID2 and **x1**, as it would lead to a calculation error.

3. The Refprop limitations for the calculation of properties of certain mixtures apply also here. In the case of mixtures in which the mixture parameters are estimated, no warning message would be seen from IPSEpro.
**DLL for property estimation of multicomponent mixtures with Refprop (Multi.DLL)**

The DLL for property estimation of multicomponent mixtures was developed in order to be able to define multicomponent mixtures of up to four components in a flexible way. Figure 10 shows the window for the definition of the multicomponent mixture composition:

![Figure 10. Definition of the Global variable for multicomponent mixtures.](image)

The variable `FluidID1` has the following format: `WWWXXXYYYZZZ`, where `WWW`, `XXX`, `YYY` and `ZZZ` refer to the three-figure reference number of the fluids that the mixture contains. The variable `x1`, with format `wwwxxxyyyzzz`, refers to the decimal part of the molar fraction of each component (i.e. 0.000). For example, a ternary mixture of butane, propane and pentane with equal molar composition would be defined as:

`FluidID1: 005070067   x1: 333333334`

The limitation on the length of variables in IPSEpro, limits in turn the maximum number of components to four.

1. If a single component fluid is to be used with this DLL, the `FluidID1` variable must be defined as `XXXXXXX`, where `XXX` is the three-figure reference number of the fluid, and `x1` is 999001.

**DLL for the equation of state of seawater (SeaWater.DLL)**

The DLL for the calculation of the properties of seawater is based on the equation of state of seawater of McDougall and Barker [4] and is only intended for the calculation of the enthalpy, entropy and density of the seawater, based on the temperature, pressure and salinity as input variables. Figure 11 shows the window for the definition of the seawater salinity (`sal`), which must be given in ppt (parts per thousand).

![Figure 11. Definition of the Global variable for sea water.](image)
3.4. Additional information

Each of the DLLs here presented here is provided with a library for their use. The components included in these libraries are limited to those needed in the simulation of waste heat recovery systems. However, extending the number of components does not represent any additional difficulty and can be done in the same way as with the standard libraries.

For debugging reasons, the DLL was created so that each time one of the functions was called, the output results were logged in the following error file: "Desktop/error.txt". For this reason, it is important to clean periodically this file (e.g. from Matlab code):

```plaintext
ferror=fopen('C:\...\Desktop\error.txt','wt');
fclose(ferror);
```
4. Publications

The developed DLLs presented in this guide were used in the following works:


5. Additional sources of information

Additional information with respect to the development and usage of DLL for IPSEpro can be found in the IPSEpro manuals:

- Section 11: Creating External Function DLLs, Model Development Kit

Other publications that present the development of DLLs for IPSEpro:


Additional information on the usage of Refprop subroutines and their linking from different applications can be found at:

- Fortran files of the Refprop installation folder

For additional support on the use or modification of the DLLs presented here contact Maria E. Mondejar at: maria.e.mondejar@hotmail.com
6. Acknowledgements

This work was developed with the funding from Lund University, and was accomplished thanks to Dr. Marcus Thern, for the support provided on the use of IPSEpro, Dr. Eric W. Lemmon for the support provided on the use of the Refprop subroutines for mixtures, and Dr. Egill Thorbergsson for the support on the development of DLLs.
7. References


Annex I. Reference number of the Refprop fluids in the IPSEpro DLL.

<table>
<thead>
<tr>
<th>fluid</th>
<th>reference number</th>
<th>fluid</th>
<th>reference number</th>
<th>fluid</th>
<th>reference number</th>
</tr>
</thead>
<tbody>
<tr>
<td>acetone</td>
<td>1</td>
<td>mdm</td>
<td>45</td>
<td>xenon</td>
<td>81</td>
</tr>
<tr>
<td>ammonia</td>
<td>2</td>
<td>md2m</td>
<td>42</td>
<td>novec649</td>
<td>82</td>
</tr>
<tr>
<td>argon</td>
<td>3</td>
<td>md3m</td>
<td>43</td>
<td>r11</td>
<td>83</td>
</tr>
<tr>
<td>benzene</td>
<td>4</td>
<td>md4m</td>
<td>44</td>
<td>r113</td>
<td>84</td>
</tr>
<tr>
<td>butane</td>
<td>5</td>
<td>methane</td>
<td>46</td>
<td>r114</td>
<td>85</td>
</tr>
<tr>
<td>1butene</td>
<td>6</td>
<td>methanol</td>
<td>47</td>
<td>r116</td>
<td>87</td>
</tr>
<tr>
<td>co2</td>
<td>7</td>
<td>mlinolea</td>
<td>48</td>
<td>r12</td>
<td>88</td>
</tr>
<tr>
<td>co</td>
<td>8</td>
<td>mlinolen</td>
<td>49</td>
<td>r1216</td>
<td>89</td>
</tr>
<tr>
<td>cos</td>
<td>9</td>
<td>moleate</td>
<td>50</td>
<td>r123</td>
<td>90</td>
</tr>
<tr>
<td>c2butene</td>
<td>10</td>
<td>mpalmita</td>
<td>51</td>
<td>r1233zd</td>
<td>91</td>
</tr>
<tr>
<td>cyclohex</td>
<td>11</td>
<td>mstearat</td>
<td>52</td>
<td>r1234yf</td>
<td>92</td>
</tr>
<tr>
<td>cyclopen</td>
<td>12</td>
<td>c1cc6</td>
<td>53</td>
<td>r1234ze</td>
<td>93</td>
</tr>
<tr>
<td>cyclopro</td>
<td>13</td>
<td>mm</td>
<td>54</td>
<td>r124</td>
<td>94</td>
</tr>
<tr>
<td>d4</td>
<td>14</td>
<td>n2o</td>
<td>59</td>
<td>r141b</td>
<td>99</td>
</tr>
<tr>
<td>d5</td>
<td>15</td>
<td>oxygen</td>
<td>64</td>
<td>r21</td>
<td>104</td>
</tr>
<tr>
<td>d6</td>
<td>16</td>
<td>hydrogen</td>
<td>65</td>
<td>r218</td>
<td>105</td>
</tr>
<tr>
<td>decane</td>
<td>17</td>
<td>nitrogen</td>
<td>57</td>
<td>r134a</td>
<td>97</td>
</tr>
<tr>
<td>d2</td>
<td>18</td>
<td>nf3</td>
<td>58</td>
<td>r14</td>
<td>98</td>
</tr>
<tr>
<td>dee</td>
<td>19</td>
<td>c4f10</td>
<td>68</td>
<td>r23</td>
<td>108</td>
</tr>
<tr>
<td>dmc</td>
<td>20</td>
<td>oxylene</td>
<td>61</td>
<td>r143a</td>
<td>101</td>
</tr>
<tr>
<td>dme</td>
<td>21</td>
<td>pentane</td>
<td>67</td>
<td>r236ea</td>
<td>109</td>
</tr>
<tr>
<td>c12</td>
<td>22</td>
<td>propylene</td>
<td>72</td>
<td>r245ca</td>
<td>111</td>
</tr>
<tr>
<td>ethane</td>
<td>23</td>
<td>propan</td>
<td>70</td>
<td>r236fa</td>
<td>110</td>
</tr>
<tr>
<td>ethanol</td>
<td>24</td>
<td>r245fa2</td>
<td>79</td>
<td>re245cb2</td>
<td>119</td>
</tr>
<tr>
<td>ebenzene</td>
<td>25</td>
<td>pxylene</td>
<td>65</td>
<td>r218</td>
<td>105</td>
</tr>
<tr>
<td>ethylene</td>
<td>26</td>
<td>parahyd</td>
<td>66</td>
<td>r22</td>
<td>106</td>
</tr>
<tr>
<td>fluorine</td>
<td>27</td>
<td>pentane</td>
<td>67</td>
<td>r227ea</td>
<td>107</td>
</tr>
<tr>
<td>d2o</td>
<td>28</td>
<td>cf3i</td>
<td>73</td>
<td>r32</td>
<td>113</td>
</tr>
<tr>
<td>helium</td>
<td>29</td>
<td>isobutan</td>
<td>75</td>
<td>r40</td>
<td>115</td>
</tr>
<tr>
<td>heptane</td>
<td>30</td>
<td>toluene</td>
<td>76</td>
<td>r41</td>
<td>116</td>
</tr>
<tr>
<td>hexane</td>
<td>31</td>
<td>t2butene</td>
<td>77</td>
<td>rc318</td>
<td>117</td>
</tr>
<tr>
<td>hydrogen</td>
<td>32</td>
<td>water</td>
<td>80</td>
<td>re347mcc</td>
<td>121</td>
</tr>
<tr>
<td>hcl</td>
<td>33</td>
<td>cf3i</td>
<td>78</td>
<td>re143a</td>
<td>118</td>
</tr>
<tr>
<td>h2s</td>
<td>34</td>
<td>so2</td>
<td>74</td>
<td>re245cb2</td>
<td>119</td>
</tr>
<tr>
<td>isobutan</td>
<td>35</td>
<td>sf6</td>
<td>75</td>
<td>re245fa2</td>
<td>120</td>
</tr>
<tr>
<td>ibutane</td>
<td>36</td>
<td>c11i</td>
<td>79</td>
<td>re245fa2</td>
<td>120</td>
</tr>
<tr>
<td>krypton</td>
<td>37</td>
<td>t2butene</td>
<td>77</td>
<td>rc318</td>
<td>117</td>
</tr>
<tr>
<td>ioctane</td>
<td>38</td>
<td>cf3i</td>
<td>78</td>
<td>re143a</td>
<td>118</td>
</tr>
<tr>
<td>ipentane</td>
<td>39</td>
<td>c11i</td>
<td>79</td>
<td>re245cb2</td>
<td>119</td>
</tr>
<tr>
<td>water</td>
<td>40</td>
<td>re347mcc</td>
<td>121</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Annex II. Code in Matlab to change the composition of the working fluid.

```matlab
%% Change the working fluid components and composition
invoke(project,'Fluid','FluidID1',fluid_number_1)
invoke(project,'Fluid','FluidID2',fluid_number_2)
invoke(project,'Fluid','x1',molar mass of component 1)

%% Resultado
function value=Resultado(proj,obj,item)
    OBJ = invoke(proj,'findObject',obj);
    ITEM = invoke(OBJ,'findItem',0,item);
    value=invoke(ITEM,'resultValue');
end

%% Input
function Input(proj,obj,item,value)
    OBJ = invoke(proj,'findObject',obj);
    ITEM = invoke(OBJ,'findItem',0,item);
    invoke(ITEM,'inputValue',value);
end
```

If Refprop subroutines are to be used from Matlab it is necessary to have the following files on the same folder of the Matlab code location:

- refpropm.m
- rp_proto.m
- rp_proto64.m

These files can be downloaded at the official web page of Refprop:


1. It is important to notice that the composition of the mixtures must be specified in molar fractions from IPSEpro, but in mass fractions if using the Matlab calls.